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Report On Red Hat Linux
 System on Hewlett Packard Computer
by Harvey M. Nusbaum
Rochester Computer Society, Inc.

A
fter I recovered from my surprise at winning the
Linux Computer at the May 11th meeting, I had to
make arrangements to get it home. Fortunately, Bev

and Dick offered to drive me and my new baggage there.
Since I did not have room for another set up in my

computer room, the equipment had to wait until I moved
everything around. A month later I got it up and running.

The next problem was that I had no experience with
UNIX or Linux and did not know what to expect. I called
several book stores and they did not have many books on
LINUX. I called Jeff’s Books in Midtown Plaza and he had
a couple of older ones, which he gave me a deal on. The book
that was the most help is Everyday LINUX by Kathy Miles
and Ethan Metsger. Even though it was a 2001 edition, it
had all I needed to get started.

Next, I did not have the username or password to get
into the system. I got the computer to boot up, but could not
go beyond the first screen. I called Steve and he got the
necessary items to me.

The opening screen is very impressive. It has a box
where you first enter the username, hit the return, then
enter the password. At the bottom of the screen, you have
four choices: language, Reboot, Session and Shut Down. At
this point, it occurred to me that the computer is set up as
a server. I should have noticed this in the book.

When I proceeded to the “session,” I was greeted by a
screen very much like the Windows desk top, but with only
three icons: Fedora’s Home, Trash, and Start Here. The last
one led to another desk top with Applications, Preferences
and System Set up. There were eight icons along the bottom:
Main Menu (Red Fedora), Mozilla web Browser (globe),
Evolution Email (box with cover), Openoffice.Org writer
(paper and pen), Openoffice.org Impress (graph and tablet),
Openoffice.org Calc (graph paper and pie chart), Print
Manager (printer) and a Square with four small squares.
The last item keeps track of where you are. I have prepared
the report on Openoffice Writer, but could not print it from
there because I have not yet installed my printer. I also
worked on a spreadsheet in Calc to see how in works.

To shut down, you point the mouse to the hat, and click
on Logoff. Then it returns to the opening screen, click on
Shutdown. The screen then goes dark.

To summarize, I am quite impressed with the package.
I feel confident that I will be comfortable with it as I use it
more. I still have a lot to learn about how it differs from
Windows and DOS. I look forward to further progress.

Review

Scanning for the SOHO
Small Office and Home Office
By Ron Matteson
2004 by Virtualbookworm.com
Publishing Inc.
ISBN 1-58939-554-9 $14.95
Reviewed by Charles Grover
Rochester Computer Society, Inc.

I
mmediately after purchasing Scanning for the SOHO I
skimmed through the volume, read a brief section or two
and knew my money was well spent. Dr. Matteson’s

teaching skills show. The book has the structure of a 13
week syllabus. Each chapter presents its ideas in clearly
organized sections, and includes a summary. Good use is
made of illustrations, charts, and tables. At several places
“quick and dirty” approaches for applying theory and
practice appear. 

Theory and practice are sufficiently discussed to provide
a grasp of how things work and an understanding of why
certain settings give better results in scanning, editing, and
printing. Considerations for commercial printing, faxing,
and display on a monitor are included. Ron helps us get both
better results and smaller computer files.

“Scanning” in the title may be misleading. In addition to
scanning, Ron introduces us to graphic editing, faxing,
printing, and digital photography. At last I feel I have a
sense of how to make use of a histogram. There is always
more to learn, but Scanning for the SOHO prepares us to
jump in or to continue from where we are without having to
fear that we don’t know what we are doing. This book is
very useful, both as a text to be read cover-to-cover, and as
a reference volume to find and use Ron’s well organized
material with ease.

Media Notes
by Bill Petitt
Southeast Virginia Computer Group
What’s on tonight?

M
ost people watch several hours of television each
day. Some long- running shows become a part of our
lives. How many times have you altered plans

because you had to catch The Sopranos or needed to find out
who killed J.R.?

TV Tome lists just about every show ever created. Along
with introductory information, you’ll find an episode guide
and cast list. The fun part is the goofs guide — a collection
of mistakes and contradictory statements made by charac-
ters. To visit this site, go here: http://www.tvtome .com/
Get to the Bottom of Windows’ 
Error Messages
Back in the bad old days, Windows crashed a lot. Anybody
remember General Protection Faults? Shudder! Windows is
much steadier these days. But when it crashes, you can bet
the accompanying error message will be as confusing as
ever. That’s why I like a couple free programs: Error
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Messages for Windows and WinErrs 1.0. They throw a little
light into an obscure corner. These programs are available
for download on the Internet. Get them at:

http://camtech2000.net/Pages/WinErrs.html and 
http://www.gregorybraun.com/

Cheap software for a student
Q. I am a high school sophomore. I bought a new computer
for my birthday. I need Micro soft Office Professional for
school, but it costs anywhere from $300 to $500. I can’t
afford that. What can I do?
A. Software manufacturers have long recognized this
conundrum. They want kids like you to use their software.
If you learn on Office, for instance, you’re less likely to use
something else when you move into the work world.

Therefore, nearly all programs are sold with academic
pricing. That means that students such as yourself, and
educators, can get these programs at cut-rate prices.

For instance, Microsoft sells the Office Student and
Teacher Edition 2003 at almost 70% off the regular price.
It’s available in select retail stores for approximately $149.
Learn more below:   

http://www.microsoft.com/office/editions/howtobuy
/student.mspx

That package does not include Access and some other
programs included in Office Professional. I found that
program on the Internet for about $200.

Other publishers, in addition to Microsoft, sell software
cheap to students and teachers. For instance, Adobe lists its
products at: http://www.adobe.com/education/purchasing
/qualify.html. Academic-priced programs are complete. I
have never run across an abridged program with academic
pricing.

Most universities sell a wide selection of programs for
their students. There are also Web sites that sell the
software. Here are two: http://www.journeyed.com, and http:
//www.academicsuperstore.com
Wireless

For those of us who already have or are planning on
installing a wireless network, the following web site offers
an interesting and easy to use way to expand your hard
drive capacity: http://www.linksys.com/HDD/

From the July 2004 issue of The Umbrella Online,
newsletter of the Hampton Roads Virginia Computing
Community.

From The Washington Post
found by Jim McGrath

Windows Security Note
Heads-up of the week: Those of you who use Windows
computers that didn’t come with backup system CD-ROMs,
instead relying on a hidden system-restore partition, may
want to read this report about how some viruses are now
programmed to copy themselves to that partition – which
can leave the computer almost permanently infected.

Privacy in the Digital Age
Court Limits Privacy of E-Mail Messages: A company

that provides e-mail service has the right to copy and read
any message bound for its customers, a federal appeals court
panel has ruled in a decision that could expand e-mail
monitoring by businesses and the government.

From The DealsGuy
by Bob (The Cheapskate) Click
Greater Orlando Computer Users Group

T
he American Water Works Assn. show we
worked in June was interesting, [http://www
.awwa.org], although most products were of an

industrial/municipal nature. I spoke to an exhibitor about
their automated meters that could be read while driving by.
He said the meter was battery operated and it continuously
emitted bursts every six seconds with all the latest data
digitally contained. The meter’s expected battery life is “ten
years”! Another company with automated meters said theirs
transmitted the data in short blasts similarly, but they are
picked up by sophisticated antennas and receivers on high
buildings, or towers in the area, saving a drive-by meter-
reader. Looks like more people will be out of work and
probably applying at Burger King since I see very few new
jobs available. I’ll tell you about the “Tapping Contest” event
in this show next month since I already have a lengthy
column for this month.

There is an announcement from Binary Research posted
on my Web site that I will also publish in the column next
month.
Quick Reply For Your E-mail

Since three editors forwarded this announcement to me,
(thanks for bringing that to my attention), I decided there
was sufficient interest for the DealsGuy column to include
it. Unlike most announcements, this one also offers a
discount for user group members. Here is the announce-
ment, but edited: “Our company, ErstenWare, would like to
announce the release of Quick Reply 2.07, a god-sent gift to
any e-mail user for Windows 98/ME/NT/2000/XP. We’d like
to offer your members a 15% discount off the regular price
of $19.95. The discount coupon code is – “975409871341" and
is redeemable at [http://www.erstenware.com/quick_reply
/discount.html].

“With this application, any person can free him /herself
from having to explain over and over again what the refund
policy is, where to get certain information, how to pay for a
product or service or who should be contacted in the event
of emergency. Even regular ‘non-commercial’ users with

Scanning for the SOHO 
Small Office and Home Office

286 pages – $14.95
For sale by RCSi member, author, and
engineer Ron Matteson. Send an e-mail
for ordering instructions to:

author@sohotechnology.info
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heavy e-mail volume can save up to 50% of time previously
spent answering e-mails by creating mini-templates ¡ a set
of phrases regularly used. Quick Reply is very good at
maintaining an orderly database of snippets, replies,
sentences or text fragments that can be inserted into the
body of an e-mail or even a regular letter within a second.
Any typical reply can be customized and personalized on the
fly and inserted via dragging and dropping. The program
supports hotkeys and macro commands. The content may be
reformatted and copied to clipboard as well.”
Get Panda Free

Panda Software feels IT Professionals have a lot of
influence in the industry. I imagine that’s why they are
offering IT professionals their AV software free. Panda
Antivirus, an excellent AV product, is again offering its AV
software FREE to IT professionals. Check the details at:
[http://www.pandasecurity.com/VIPIT]. Thanks to Ira
Wilsker, an APCUG director, for making us all aware of that
one. I use Panda, although I can’t seem to get my latest
version to work right, so far. Their tech support has not
been much help either. Last year’s ran just great, but I
wonder if there are bits and pieces left that interfere causing
it to lock up, even though I removed the previous version
per their instructions.
News From Aladdin

Aladdin has a new user group coordinator. If you didn’t
see this posted on my Web site, Ernest Breaux is the new
kid on the Aladdin block and will take care of your UG
requests. He announced new products and here are his
descriptions:

“Four essential Computing solutions from Aladdin
Systems; Internet Cleanup 4.0, StuffIt Deluxe 8.5, Spring
Cleaning and SpamCatcher For windows are now available.

“Introducing New Internet Cleanup 4.0. This offers the
most powerful protection yet for users who want to protect
their privacy and guard against spyware. Spyware slows
down your computer, invades your privacy and can reveal
sensitive information. These new tools eradicate spyware
and prevent sensitive information from leaving your
computer. IC4 includes a Personal Information Blocker that
safeguards names, phone numbers, addresses, credit card
information and bank account numbers. IC4 prevents these
and other specified pieces of information from being trans-
mitted over the Internet without users’ permission. In
addition, IC4 includes file and folder locking as well as
application locking features. Only IC4 provides the user all
of the tools necessary to protect their privacy, security and
PC, all in one complete and integrated package.

“Special offer! $19.99 for Internet Cleanup 4.0, regularly
$29.99, offer valid through the end of Sept. [http://www
.aladdinsys.com/ug/cleanup]

“ZIP, ACCESS, BACKUP, AND SEND! StuffIt Deluxe
makes using the Internet fast, safe, and secure! Whether
you store data securely in space-saving archives or safely
send it to friends and co-workers, StuffIt makes it easier
than ever to backup, upload files, and more, automatically!
Reclaim wasted space on your hard disk! Store data in
archives up to 98% smaller than their original size! Quickly

and easily backup your data! Schedule backups to happen
while you are away! StuffIt will take care of it all and send
you a message when the backup is completed! Super search
your data! Get instant access to any file whether it’s on the
network, in a local hard drive, or even burned onto a CD in
the office next door, StuffIt will find it for you! Integrated
with Windows and Microsoft Office! 100% integration with
MS Word, Excel and Outlook eliminates 90% of your
keystrokes. Compress, save, and send in a single click!

“Special offer! $29.99 for StuffIt Deluxe 8.5, regularly
$39.99, offer valid through the end of Sept. [http://www
.aladdinsys.com/ug/stuffit]

“One-click cleanup. Easy for you. Good for your PC.
Programs and pictures, folders and files, it’s amazing how
quickly a hard disk fills up! When the time comes to clean
up, let Spring Cleaning carry the load. From deleting
duplicates to archiving programs, Spring Cleaning puts a
suite of easy-to-use tools and one-click solutions at your
fingertips. Fix Registry problems caused by old files nothing
makes your computer more unstable than a Registry full of
junk. Bad data builds up over time, causing error messages
and a host of other problems. Spring Cleaning sweeps out
the clutter to keep your system running smoothly.

“Special offer! $19.99 for Spring Cleaning, regularly
$29.99, offer valid through the end of Sept. [http://www
.aladdinsys.com/ug /spring]

“Special offer! $19.99 for SpamCatcher, regularly $29.99,
offer valid through the end of Sept. [http://www .aladdinsys
.com /ug /spam] I featured SpamCatcher three months ago
so I know you are already familiar with it.

Special offer! $49.99 for The Big Mix, regularly $59.99,
offer is valid through the end of Sept, but try anyway if you
miss that deadline. [http://www.digitalriver.com/dr/v2/ec
_MAIN.Entry17c?CID=152708&SID=1839&SP=10007
&PN=5& PID=624494]

That’s it for this month. Meet me here again next month
if your editor permits. This column is written to make user
group members aware of special offers or freebies I have
found or arranged, and my comments should not be inter-
preted to encourage, or discourage, the purchase of any
products, no matter how enthused I might sound. Bob (The
Cheapskate) Click [bobclick@mindspring .com]. Visit my
Website at [http://www.dealsguy.com] for interesting articles
from user group newsletters. I also posted some interesting
NEW Web site pages for your viewing. They contain new
product announcements that I received over a period of
time. More will be forthcoming when I get the ambition.

Internet Annoyances
by Sherry Zorzi

Cajun Clickers Computer Club
Baton Rogue, Louisiana

D
on’t post your address on publicly-accessible websites
(newsgroups, chat rooms, directories). Web “crawlers”
harvest these addresses for spammers’ mailing lists.

You can obtain free, “throwaway” e-mail addresses at sites
like Yahoo (www .yahoo .com) or Hotmail (www.hotmail
.com) to use in these situations. 
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When you register for a legitimate web site (Microsoft,
Amazon, Delta Airlines, etc.), opt-out of any newsletters or
mailings they offer to send you. If opting out is not offered,
don’t register for the site unless you want advertising email!

Use “filters” in your email program to automatically
route suspected spam to a special folder, which you can
check periodically and delete. Or use special (free!) software,
like MailWasher (www.mailwasher .net) or K9 Spam Killer
(www.keir.net/k9 .html) to automatically check incoming
mail and handle suspected spam for you.

Don’t ever follow directions to “unsub-
scribe” or stop receiving mail, unless you
know you are dealing with a reputable source.
Replying to the message or clicking a link to
supposedly unsubscribe is often just a ruse by
the spammer to verify that your email address is valid and
that you are naïve enough to open spam. You will get more,
not less, spam!

Use SpamCop (www.spamcop.net) to report spam. The
service is free. They will automatically report, in your name,
the true source of the spam to the appropriate ISPs. 

Send a copy of the spam, with full headers, to the
Federal Trade Commission at uce@ftc.gov. They keep a
database of fraudulent spammers.

Support strong legislation at the state and federal level
to stop the scourge of spam!!! Write, call or email your
Senators and Representatives and urge them to support
strong legislation.

Popup
Advertising that “pops up” in a small

window of its own. Some websites pop up an
unsolicited ad in a window on top of the page
you are trying to view. Others hide the popups
beneath the site you’re visiting, so that you see
it when you finally close your main window.

Some sites pop up several, or even dozens of popup ads –
sometimes “freezing” the computer. The new popup scourge
is controlled by one or more programs hiding on your
computer, causing popups even when you are not online!
They are all bad, bad, bad!

The best way to squash popups is with free software like
Popup Stopper (www.panicware.com). Works perfectly and
the price can’t be beat!

Never, ever forward anything to everyone in your
address book, no matter how “true” it sounds. Even if it is
supposedly from IBM, Microsoft, or the government.

Type a few keywords from the email into a search
engine like Google (www.google.com) and follow several of
the links that come up. You should quickly discover that the
mail is a hoax.

Before you hit “forward”, check out the “story” on one of
the websites that specialize in de-bunking urban legends
and hoaxes:

Snopes (www.snopes.com)
Urban Legends (www.urbanlegends.com)
HoaxBusters (www.hoaxbusters.com) 

Spyware
Technology that aids in gathering information about a

person or organization without their knowledge. Spyware
usually comes “hidden” within software you voluntarily
install. Along with what you wanted, you also get a small
piece of software than installs itself behind the scene and
sends back information on your surfing habits to an adver-
tiser or marketing company. 
C Ad-aware (www.lavasoftusa.com)
C SpyBot Search and Destroy 

(http://www.safer-networking.org/en/index.html) 
Cookie

A small text file placed on your computer by a website
you visit. Cookies can be innocent, but some operate as spy-
ware. Spyware-controlling software like Ad-aware will
control spyware cookies, too. You can also exercise some
control over cookies in Internet Explorer by clicking Tools,
then Internet Options. Click the “Privacy” tab to allow or
disallow various kinds of cookies on your system. Be aware
that some features of some sites won’t
work properly unless you allow cookies.
Virus, worm

A piece of programming code that
causes some unexpected and usually un-
desirable event, such as spreading itself
(in your name !) to everyone in your ad-
dress book, locking up your computer, or
deleting important files. They can be transmitted as attach-
ments to an e-mail, as downloads, or be present on a diskette
or CD. 

Install antivirus software and keep it up-to-date.
Popular brands include McAfee Virus Scan, Norton
Antivirus, and TrendMicro PC-cillin. Free antivirus soft-
ware, which works well, is available at www.grisoft.com.
House Call, a free online virus scanner, is available from
TrendMicro at http://housecall.antivirus.com/housecall
/start_corp.asp. 

Don’t allow “autopreview” features on your email pro-
grams. When an email message is previewed, it is really
“opened,” which can trigger a virus.

Don’t open emails or attachments from unknown
sources. Even when mail is from a trusted source (such as
your mother), don’t open any attachments unless you are
expecting them without checking with the source first to be
sure they intended to send the attachment and are sure it’s
virus-free.
Trojan horse 

Similar to viruses and worms, Trojan horses are particu-
larly nasty as they can open up ports on your computer,
making it possible for an intruder to control your computer
remotely.

If you use the available tools, your
Internet experience will be more pleasant
for you, your computer, and for all your
email correspondents. Don’t forget the most
important tool of all – Your Brain! Use it.

Anti-virus software is not great at
catching Trojan horses. You should install
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and periodically run a Trojan scanner, such as the free
SwatIt (www.swatit.org). 

Weather and Tropical
 Information on the Net
by Ira Wilsker
APCUG

N
OAA logo-Select to go to the NOAA homepage We are
now a few weeks into the official hurricane season,
and many of us can take positive advantage of the

Internet resources that can help keep us informed about
severe weather, as well as provide a margin of safety for our
families. The Internet is but one excellent storm information
tool, and can be used as a valuable adjunct to the instant
notification available on NOAA weather alert radios.

Select to go to the NWS homepage.
The primary source of public weather
information is the National Weather
Service. Visitors to this website will find
the front end of very comprehensive and
current information. Immediately visible
on the center of the page is an interactive

national map showing current watches, warnings, state-
ments, and advisories. Tabs at the top of the map will open
additional interactive maps showing cur-
rent graphical forecasts, national maps,
Doppler radar, river and flood information,
and a color enhanced national satellite
image. Clicking on any part of the map
will open a regional and detailed map
giving explicit information on the area
selected. From this local map a new (2003)
feature allows for a Pin-Point Forecast which will give a
highly localized current conditions and forecast, often from
within a two mile radius of the selected point. This is helpful
because all of us have seen circumstances where it is cold
and rainy on one side of town, and clear and warm on the
other; this pin-point feature takes the local differences into
consideration. Highly detailed pin-point reports can be
generated for almost any location, including printable
forecasts, hourly graphs and tables, marine information
(when appropriate), aviation weather, fire conditions, maps,
a glossary, and other information. On this and almost all
other weather.gov pages is a box with the notation Enter
Your City, ST or zip code where the similar information for
any other location can be immediately and easily shown.

NHC logo
For those of us
living in Hurri-

cane Alley, the National Hurricane Center site should be a
priority bookmark or shortcut. From this main page any
current tropical events from tropical depressions to hurri-
canes will be prominently displayed. If such a storm is in
progress, clicking on the name of the storm will bring up all
of the latest official warnings, statements, predictions, and
maps. The listing and links Tropical Weather Outlooks and
Full-Basin Maps will open to the latest tropical outlooks for

all tropical events in the Atlantic or eastern Pacific, as well
as a map which will graphically show any potential tropical
threats. For those who prefer to still do their own storm
tracking, detailed hurricane tracking charts are available
for free download at the bottom of the page. Self- tracking of
storms may be becoming obsolete, as long as Internet access
is available, because this site also provides detailed maps
showing the location, strength, and projected path of any
current storms.

There are many decent commercial
weather sites available, one of the most
popular being the Weather Channel.
This page is easily customizable to pres-
ent the viewer with local, rather than
national forecasts and information. Also
on this page are airport and golf
weather forecasts, which many users

will find helpful. An excellent topical update page is avail-
able from the weather channel, using the same graphics as
shown on the Weather Channel TV Tropical Update at 10
minutes before every hour. Several specialized pages are
also available for the several weather related topics such as
health (air quality, allergens, UV risks, and more), travel
(vacation planning), driving (highway conditions), special
events (sports and other local events), recreation (golf,
boating, skiing), home and garden, international weather,
and other specialized topics.

WeatherBug – Your Weather
Just Got Better The Weather
Channel, as well as a very popular

third party utility Weather Bug, and some other utilities,
can deliver real-time local weather to your computer. These
programs show current local temperature and weather
conditions on your desktop. Available in both free (advertis-
ing supported) and commercial versions, these utilities can
also show detailed local conditions, and notify the user of
severe weather conditions. One warning — some versions of
Weather Bug offer to install a free utility Attune which will
help keep the software and drivers on the computer up-
dated, but many of the anti-spyware companies list Attune
as spyware. Personally, I like Weather Bug, but choose not
to install the optional Attune that may come with it.
Weather Bug is affiliated WeatherNet. 

Weather Net, which offers highly
detailed hyper-local weather infor-
mation from over 6000 automated

and net connected local weather stations in schools, librar-
ies, and other local facilities. It is common for local TV
stations, and some newspapers, to also sponsor a local
weather page complete with the stations live local radar
image. These can be an excellent resource for highly detailed
and accurate local information.

In March, 1994, when the Internet was in its infancy,
and there was almost no local weather information available
on the net, I started the Golden Triangle Weather Page,
hosted locally by Eonet, at www .beaumontweather.com.
This is a non-commercial site with very comprehensive local
(Beaumont, TX) weather resources, satellite images, radar,
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local weather, and links. When a tropical storm or hurricane
threatens, it also typically includes real-time information
and maps from a variety of resources, including the national
Hurricane Center, the U. S Navy (arguably the best of the
hurricane tracking and prediction maps), and the Tropical
Prediction Center at the University of Hawaii.

Information is power, and with this information we can
help protect our homes and our families.

From the July 2004 issue of Bits & Bytes, Official
Newsletter of the Tampa Bay Computer Society.

Internet News Services
 Explode Online
by  Jim Edwards
via www.articlecity.com

I
t seems no matter how much information comes avail-
able online, people thirst for more.

To illustrate this point, just take a look at all the
online news services sprouting up on the web like garden
weeds.

With the click of a mouse you can instantly search
thousands of news sources for specific and timely informa-
tion on virtually any topic you
choose.

Heck, if you’re a real news
junky, you can even get
up-to-the-minute news emailed
straight to your desktop!

Now, I’m the first one to say
that nothing beats a good
old-fashioned newspaper you hold
in your hands.

Few things rate as relaxing as a cup of coffee, a quiet
morning, and today’s newspaper ready for my inspection. In
fact, my day doesn’t officially start until I walk to the end of
my driveway to retrieve the paper (occasionally from under
a bush).

But as much as I love the paper, it rarely contains
stories on highly-specialized subjects such as the latest email
marketing laws, html parsing, and search engine promotion.

Of course, it doesn’t make sense for virtually any local
newspaper to carry news about email marketing laws (other
than how they affect consumers) because the market
demand simply doesn’t exist on that level.

However, around the world, thousands of people just
like me want to know the instant a news story breaks on the
latest “Can Spam” legislation, and that’s where online news
services come into play.

Log on to http://news.google.com, http:// news.yahoo
.com and www.news.com to search thousands of different
news sources from around the world.

On these sites you can dig up information on anything
from current world events and your favorite Spanish soccer
team, to cattle tagging regulations in Argentina (no kidding)
and the exploding online auction markets in mainland
China.

News from around the world on virtually any subject
waits literally just a few keystrokes and a mouse-click away.

An incredibly useful feature offered by many of these
sites includes email notification based on your keyword
search criteria.

So instead of paying a “clipping” service to find articles
and send them to you, these websites will do it free.

Now how could you use this type of news notification
service?

Well, imagine you own stock in a specific company. You
could subscribe to a number of different news services and
have them send you breaking stories about the company,
CEO, affiliated companies and anything else you choose.

Or, let’s say you deal in a very specific industry, such as
real estate investment publishing.

You could sign up to get notified any time a news story
gets published about changing regulations, interest rates or
other factors affecting your business.

All this online news certainly does not rate a substitute
for morning coffee, local and national news, and an impor-
tant ritual to start the day, but it has a place, especially for
extremely specialized areas of interest, hobbies, or business
news.

Watch for many new services, software, and opportuni-
ties to arise from this growing and dynamic area of online
publishing.

About The Author: (c) Jim Edwards - All Rights reserved. Jim
Edwards is a syndicated newspaper columnist and the co-author
of an amazing new ebook that will teach you how to use free
articles to quickly drive thousands of targeted visitors to your
website or affiliate links. Need MORE TRAFFIC to your website
or affiliate links? “Turn Words Into Traffic” reveals the secrets for
driving Thousands of NEW visitors to your website or affiliate
links... without spending a dime on advertising!
http://www.turnwords intotraffic.com 

Computer Problems
by Don Singleton
Tulsa Computer Society

T
he week of June 13-19 was NOT one of my best weeks.
I had recovered from the 28 hours my power was off a
couple of weeks earlier (due to a major storm that hit

Tulsa), but when I entered my office Tuesday morning (June
15) I could not access any files on my D: drive (which held
all of my data).

I thought the hard drive had crashed, but that was not
the case, because the 80 gig drive was split into two 40 gig
partitions: D and E, and I could access the files on drive E
just fine. Drive D was totally unaccessable. I could not read
anything from it, I could not save anything to it, Partition
Magic showed the drive was completely full, yet I could not
get Scan Disk to touch it. One of the times when I tried to
save a file on it I got an indication it was not formatted, so
lacking any other alternatives I told Windows to format it,
but it timed out and said Windows could not format it.

Because my setup made it difficult to do a backup of it
my most recent backup was from the end of February, but
I restored that backup on a spare drive I had, and installed
it, and I was able now to access files on Drive D, but I could
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not connect to the Internet. When I opened a command
window and did a IPCONFIG /RELEASE and IPCONFIG
/RENEW it hung for a long time and then came back with
DHCP NOT ACCESSABLE. DHCP is what assigns dynamic
IP addresses, which is what Cox uses for residential custom-
ers. When I did a IPCONFIG it showed I did not have an IP
address, but if I would wait a few minutes and check again
I did have an IP address. I could access a web site if I knew
it's IP address, but when I tried going for it by name (like
tcs.org) I got a DNS error. I called Cox Technical Support,
and spent a long time on the phone, first with the Tier 1
technician, and then with a Tier 2 technician, and they had
me check a number of things, and determined my problem
was clearly hardware, and in all probability it was the
modem, so they scheduled a service technician to come out.
Unfortunately the earliest he could be scheduled was 12-3
the next day, and he had a really bad day, and it was after
3 pm before he got here. He was very knowledgable (as
almost all Cox technicians I have ever met have been) and
he tried many things, both with his laptop and my com-
puter, using both his modem and mine on both machines,
and he tried using my DLink USB Converter, using his
Linksys USB Converter, and connecting the modems
directly to a NIC I had in my computer, and nothing would
work. After several hours he did an exhaustive test with his
laptop, using both my modem and his modem, and decided
that my modem was working just fine, and the problem
must be on my computer, but he was not allowed to work on
my computer.

Wednesday and Thursday were spent trying to get my
computer working again. Lee Pang stopped by CompUSA
and bought me a new 80 gig drive, and we removed the old
80 gig drive and inserted another 80 gig drive onto which I
restored my most recent backup (from the end of February),
then we spent most of Wednesday trying to get my computer
to access the Internet. I could not find my Windows 2000 CD
but Don Greer brought over one for me to try, but both that
CD and another one someone else loaned me could not
install Windows on top of the old Windows (I wanted to
avoid having to reload all of my programs). Finally I tried
hooking up the modem to one of the Win98SE computers
from our computer refurbishing inventory, and it was able
to connect to the Internet, but the computer was too old to
recognize my 80 gig data drive, and with my disability I find
it difficult to move a computer from one room to another, but
my neighbor, Darline McGinnis, was kind enough to bring
my Image Machine into my office from the other room, so
that I could get back online with that computer. Jim Erwin
showed up with his Win2K CD, so we tried it, but it gave the
same result, although for some reason it did offer me the
alternative of repairing Windows 2000, so we gave that a
try. The repair worked, in that Windows 2000 was now able
to connect to the Internet, but each time I booted the system
up it kept bringing up several copies of Windows Installer
saying I needed to reinstall some program, but with one
exception (EZ Creator) it did not tell me what program I
needed to reinstall, so I gave up and decided to start with a
blank HD and installed Windows 2000 from scratch.

Since the reason for the reinstall was to be sure I could
browse the internet and get my mail, those are the first
things I did, but once I was certain both worked the first two
programs I installed were Norton Anti Virus and Zone
Alarm Pro (my AV program and my firewall). Before they
were installed I only read email from people I know (al-
though when I first started reading email Outlook Express
was showing the Preview Pane) and therefore some mes-
sages I did not intend to read were opened (in the Preview
Pane). That is why one should normally disable the Preview
Pane. I definitely did not click on any attachments until I
got Norton and ZoneAlarmPro installed, and I don't know
whether it was because some undesired messages were
opened in the Preview Pane, or whether it was my short
term lack of a firewall, but I was infected by the W32
.Spybot.Worm. This just goes to demonstrate that one should
always have a good AntiVirus program (with recently
updated virus definitions) and a good firewall active anytime
one goes online.

I still have a lot of programs that need to be reinstalled,
but I was able to get caught up on my email by Friday
morning, and now (Saturday afternoon) I have most of the
programs I use frequently reinstalled.
One Good Thing

There was one good thing: I took the bad 80 gig HD into
the Imaging Room (a bedroom I have converted into a
workroom for refurbishing computers for HelpingTulsa) and
put it into my Image Machine, planning on reformatting it,
when I took one last look at it, and found I could see files on
Drive D!!!!. I took the disk back to my Dell, and again I could
not see anything on drive D, so I took it back to the Image
Machine and tried copying the files off to another HD. I
could not get them all at one time, because there were still
errors on the HD which aborted a copy, but I did the copy
several directories at a time, resuming from the point right
after the file which could not be copied, and I got 98% of my
files back. A lot of the filenames were converted to upper
case (I wish I knew some way to reverse that), but at least
I got most of them back.

I want to thank Lee Pang, Don Greer, Darline
McGinnis, and Jim Erwin for their help in getting me online
again, and I also want to thank Paula Sanders for being
willing to go down to her Safe Deposit Box to get her
Windows 2000 CD, before I found others who could loan me
theirs (I also finally found my CD, after trying CDs from
others). I am very fortunate to have so many good friends.

From the July 2004 issue of I/O Port newsletter of the
Tulsa Computer Society.

Getting to Know Google
by Billy Mabray

Oklahoma City PC Users Group

T
hese days, whether you consciously choose it or not,
your Web search engine is probably Google
(http://www .google.com). That's because most search

sites, whether they admit it or not, are powered by Google.
And, why not? Google rose to the top of the search engines
because its formula provided more relevant search results



The RCSi Monitor / August 20048

than any other. Also, its deceptively simple page makes it
fast and easy to use.

I say deceptively simple because, underneath that
friendly, colorful logo is a powerful search system that can
accept queries as complex as you want to make them. Many
people don't realize that if they do not find what they want
on the first try, there are techniques they can use to improve
their results. There are also ways to search Google that are
more appropriate for certain specialty queries. And, Google
is hiding a few extras that take it beyond a search engine
into an amazing reference tool.

Let's start with an example, We're cooking dinner
tonight, and we need a recipe for spaghetti sauce that does
not use sugar. We might go to Google and type in this:
no sugar spaghetti sauce recipe

Google tells us we have about 56,000 results to wade
through. A daunting task, considering the first page doesn't
seem to contain anything relevant. The first thing we will
try is grouping our search terms into phrases, using double-
quotes. This tells Google that certain words should be
searched for together. So, we try this:

"no sugar" "spaghetti sauce" recipe
Your search contains a lot of common words that could

appear together in different contexts than what you are
looking for. Unfortunately in this case, our first page of
results is still not as relevant as we would like. The next
thing we will try is searching for pages that do not contain
a certain term:

-sugar "spaghetti sauce" recipe
This tells Google that we want pages that are about

"spaghetti sauce" recipe, but specifically do not contain the
term sugar. That seems to have done it — our first page of
results is chock full of spaghetti sauce recipes that don't use
sugar. "Subtracting" a term can also be useful when what
you are searching for has multiple meanings. For example,
if you are researching the "Holy Grail," you might want to
add "-Python" to your search to eliminate all the references
to the movie Monty Python and the Holy Grail. Now, maybe
spaghetti sauce is too specific ù we might want to also
consider marinara sauce. In that case, we use Google's or
syntax.

-sugar "(spaghetti | marinara) sauce" recipe.
When there are multiple words that will satisfy our

search, we can group them with parentheses and separate
them with the "pipe" character | a vertical line that is most
likely on the right-hand side of your keyboard usually on a
key with the \ (backslash) character, Google will then
search for references to "spaghetti sauce" or "marinara
sauce."

At this point, we've become so intrigued by what we can
find with Google, we've completely forgotten about dinner.
Now we are interested injust how many different chicken
casserole recipes we can find. Here's one way:

"chicken * casserole" recipe
Notice the asterisk. This is called a wildcard. It tells

Google that we don't care what word comes between chicken
and casserole, but there should be something there. This can
be particularly useful when you know most of a title of

something, but are unsure of all the words. This particular
search brings back all kinds of chicken casserole recipes.
Something tells me we better just eat out tonight.

Besides its standard Web search, Google has many
specialty searches that are triggered either by a keyword or
simply by what you are searching for. For example:

site:microsoft.com "Internet Explorer" patches
This searches for references to "Internet Explorer"

patches on microsoft.com only. If your favorite Web site does
not offer a search function, this is a pretty good substitute.

Maybe we want to know which sites on the Web link to
the OKC PC User's Group Web site:

link:okcpcug.org 
We can also tell Google that what we are looking for is

in an Adobe Acrobat PDF file:
filetype:pdf refrigerator manual
Google pays attention to what you are searching for, and

offers helpful services based on what it thinks you want. For
example, have you ever noticed Google shows your search
words in the blue bar above your results? The search terms
that are underlined link to a definition of that word at
dictionary.com. If you spell a word wrong, Google will
prompt you with the correct spelling and ask if you would
like to search for that instead.

Google has many tricks like this up its sleeves. Search
for a phone number, and Google will do a reverse lookup on
the number. Search for a name with a city and state and/or
zip code, and Google will look up their phone number.
Search for an address and you will get links to maps of that
location. Include a zip code with your search terms, and
Google will offer you local results — Web sites for locations
near the zip code, ordered by distance. You can even type in
a shipment tracking number, and Google will figure out who
the shipping company is and give you a link to the tracking
information.
Google offers some services that have nothing to do with
searching. Try this:

68.12 + (68.12* .2)
The Google calculator will return the result of this

computation. Fun, although, admittedly, not particularly
useful. The Google calculator can be useful though, for
things like conversions:

68mm = ? inches 
You can do all kinds of conversions using Google — a

handy tool whenever you get around to making that spa-
ghetti sauce.

Google is much more useful than most people realize —
we've only scratched the surface of what Google can do. If
you are interested in more, check out O'Reilly's Hacking
Google by Tara Calishain and Rael Dornfest. It includes
many more search tips, and information for programmers
who want to include Google search results in their applica-
tions [you can buy it at a users group discount.] As you
explore what Google can do, you will probably discover that
Google feels like more than just a Web site.

In fact, Google is your friend.
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Online and In Person
by Billy Mabray
Oklahoma City PC Users Group

I
n the early days of the Internet, a common fear was that
people would spend too much time online, creating a
world of isolated loners. Computer users would stop

spending time in the real world, preferring to type instead
of talk. While this may be true for some people, many others
are finding the Web has enhanced their social life, not hurt
it. The proliferation of e-mail, instant messaging, and chat
rooms are evidence that people are connecting more now
than ever before.

What about real life social interaction? People still like
to meet in person, and there are many Web-based services
to help people do just that. These services are blurring the
lines between virtual and real communities. People are
finding friends online and getting together in real life.
Others are using the Internet to keep in touch with their
real-life acquaintances. Internet users are finding they can
connect with other people better than they ever have before.

A common example of virtual communities creating real-
life friendships is PC user groups. People typically learn
about their local group through that group’s Web site. Much
of the group’s communication is done online. For these
groups, though, the real point of using the Internet is to
facilitate real-world get-togethers. Meetings, presentations,
and study groups bring people together who have similar
interests, but would otherwise have not found each other.
Web sites and mailing lists allow for efficient communica-
tion, while group activities create opportunities for learning
new things and meeting new people.

Meetup.com offers a similar service, but for a broader
range of topics. Meetup.com arranges monthly get-togethers
in cities around the world on a vast array of topics. For
example, the third Tuesday of every month is International
Poker Meetup Day. If you are interested in meeting poker
players in your area, visit the Web site, type in your zip
code, and join the poker meetup nearest you. Members vote
on where to meet each month, and they RSVP through the
Web site. If enough people RSVP, the get-together will take
place. Meetup.com offers many features for communicating
with other members, planning agendas, and more. There are
literally thousands of topics, with new ones being added all
the time, so you are bound to find something you are
interested in.

For those who are interested in communicating and
spending time with friends they already have, there are
online services to help with that too. Yahoo Groups, for
example, lets you set up your own personal portal. A Yahoo
Group includes a mailing list, photo gallery, polls, online
chat, and more. You can set up a group for your family and
invite all your relatives to join. Then the whole family can
upload photos, plan the next reunion, or talk about what’s
been going on in their lives. Similarly, sites like Classmates
.com or Reunion.com allow old classmates and military
personnel to reconnect with each other. These services are
a great way for people who don’t get to see each other very
often to stay in touch. 

Along the same lines is a wave of new services known as
social networking applications. There has been an explosion
of these sites in the past year: Friendster, LinkedIn, Orkut.
The idea here is to map relationships - someone invites you
to join, and you in turn invite all your other friends to join.
The Web site shows you people who are directly connected
to you (friends), as well as those who are connected to you
through other people (friends of friends). You can then use
the service to keep in touch with your friends, and to meet
new people through friends you already have.

So, are these virtual or real communities? The line is
blurring, and the distinction between the two will most
likely disappear in a few years. Technology continues to
improve the way we interact. Rather than turning us into
loners, the Internet is helping us to make new friends, and
to keep in touch with old ones.

Billy Mabray and his wife, Angela, own Smart Goat, a
software development and Web design business. They are
members of the OKCPCUG. Comments or questions on the
article are welcome and can be addressed to: billy
@smartgoat .com.

From the June 2004 issue of Diablo Blue, newsletter of
the Diablo Valley PC Users Group, CA.

Comdex is History
Comdex was inflated, owners were arrogant, and
since 1998, it was clear the show was destined to
fall into the bit bucket. 
by Steve Bass, PC World
Author, PC Annoyances

I
n a downward spiral for the last five years, Comdex is
finally kaput. The show owners declared it dead when
they cancelled the November, 2004 event. Many of you

have been attending Comdex since close to forever, and most
of you knew the show was destined to fall into the bit
bucket. 

Good riddance. In the last few years, the show’s become
an empty shell of its previous life. So much so that room
prices on the Strip were as low as $50 a night during
Comdex week in 2003. 

The problem was I couldn’t not attend.  Even though I
didn’t enjoy myself and couldn’t find lots of really nifty
products to write about, I still drove in from Pasadena and
stayed for two nights. Call it nostalgia. Or maybe I was just
hoping there would be one more chance that Comdex would
get back on its feet. 

But nope, it’s really over. 
Dig Into the Files
I dug around and found some of Comdex the missives I sent
in the last few years. 

December, 1998: Comdex is toast. It’s fading rapidly and
while it’ll always be with us, it’s never going to be “bigger
than ever.”

I polled lots of people and all agreed. The attendance
was dismally low. Softbank’s claim of 250K attendees was a
lie. It was based on registrations — not attendees — some-
thing made lots easier because the normal $100 “Exhibits
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Only” fee was waived when you registered on Softbank’s
Internet site.

My best sources are the cabbies, and all emphatically
said 60- to 90K tops. And it was easy to see. I never had to
wait more than five minutes for a cab. Ever. Even at
5:00pm. Parties weren’t well attended. In fact, for the first
time ever, there was actually walking-around room at the
exclusive Spencer party.

Iomega was back promoting their Clik gizmo. But wait,
weren’t they doing that last year? And Castlewood was
pushing their 2.2GB ultra SCSI removable storage disk that
wouldn’t ship until next summer.

The quality of the show was also disappointing. The
Sands was filled mostly with OEM stuff-lots of system
boards, drives, memory checking devices, and other boring
equipment. Joe Bohannon nailed the entire Sands Conven-
tion Center in five hours, something that ordinarily takes a
day and a half.

I couldn’t even find anything very inspirational. 
For instance, Creative Labs had a second generation

Live sound card. Wow. Sure, there were some booths with
interesting things — wireless networking was cool, as was
HP’s Jornada, their oddly named sub-notebook — and I
found a few products to write about.  But overall, I could’ve
done just as well surfing the web.

Why has Comdex slowed down? Simple: Games went to
E3, anything about the Web went to Internet World, and e-
commerce apps also needed their own specialized trade
shows.

Worse, it appears Softbank’s jacked up the price on
everything. That’s happened before, but my hunch is
vendors aren’t going to take it much longer. (That happened
to the Food Show when Pepsi and Coke pulled out, literally
destroying the event. And Deere, the largest exhibitor of the
Machinery Show, left the show high and dry when told
they’d be charged double — the new policy put them into
both agriculture and machinery.)

At Comdex, the newly remodeled Las Vegas Convention
center was missing Intel, IBM, and other big vendors. The
Lotus exhibit consisted of a bus in the parking lot with a box
of Winchell’s donuts on the table. One of the Lotus reps said
this is their last Comdex. 

On the exhibit floor, the Japanese companies were
slugging it out, with Sony and Samsung making lots of
noise, each trying to impress the other. Phillips created a
small, loud city, and Microsoft was in their corner with more
vendors than spectators.

Me? At $329 a day for the hotel room and the five days
lost...I dunno. It may also be my last Comdex. 

October, 2000: Comdex is struggling. That’s because
most other trade shows specialize while Comdex tried to
cater to everyone. Funny, in the past Comdex charged an
outrageous $100 for admission just to the exhibit floor. This
year they’re offering a free exhibits pass. (Too bad the hotels
haven’t caught on to this trick...) This is my last Comdex, for
sure.

December, 2001: The Comdex mood this year was all
business, with somber overtones. Journalists clustered

around in small groups, talking about layoffs, and concerned
with the dozens of freelancers gone missing. Lots of PR
people didn’t make it to Comdex; many of those who did
were kvetching about having to share sleeping rooms with
colleagues.

I don’t know that I’ll be back next year. While the
exhibit floor didn’t have the sizzling array of products I saw
at previous Comdexes, like last year, the place to be was the
evening press events: Showstoppers, Digital/mobile Focus,
and Silicon Northwest. 

December, 2003: Sleeping rooms are under $60. The
show floor at the Convention center has lots of curtains and
barriers to make it look as if there are lots of vendors. The
aisles are narrow so it feels crowded. There are practically
no big vendors, except for Microsoft, and even their exhibit
is small.

I’ve said it every year, but this time I really mean it.
This is definitely the last Comdex I’m going to attend. (And
I’ll see some of you at the Consumer Electronics Show in
January, 2005!)

Steve Bass is a Contributing Editor with PC World, a 23
year veteran of PIBMUG, and a founding member of
APCUG. He’s also the author of PC Annoyances: How to Fix
the Most Annoying Things about Your Personal Computer,
O’Reilly Press. It’s available on Amazon for $7.98 at
<http://snurl .com /annoyances>.

Retrieving "Permanently" Deleted Files
by Don Edrington
PC Chat

A
question I'm often asked is: "If I delete a file and then
empty the Recycle Bin, is there any way to recover
the file?" Well, emptying the Recycle Bin does not

instantly destroy the files it contains; their names are
altered slightly and will remain out of view on your hard
drive for a while. The sooner you try to recover a purged file,
the better your chances for success. 

There are data recovery companies that specialize in
restoring these files; but Jack Konen wrote to tell about
doing it himself. Jack went searching for software on the
Internet and found a number of programs at different prices.
However, he also found a free one. 

Jack downloaded it onto an external hard drive, and has
used it to successfully recover a number of files. The pro-
gram is called "Restoration v2.5.14" and can be found at:
http://www.pcworld.com/downloads/file_download.asp?fid=
23108&fileidx=1. The magazine also has some helpful free
newsletters at http://www.pcworld.com/. 

One of the main things to be careful about, when trying
to recover a deleted file, is not to give another file the same
name. Windows folders can only hold one file with a given
name — adding another with the same name will replace
the first one. Yes, you can have identically named files in
different folders, but giving each its own distinctive name is
much safer. 
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Doing Arithmetic  with MSWord 
Since MSWord is the word processing program used by

most businesses, it's helpful to know that it has some
built-in "calculating" commands. If, for instance, you
prepare an invoice which lists the name of an item, a
quantity, a unit price, and a blank space for the total, you
can have Word calculate and insert the correct amount. You
can also have the grand total of multiple calculations appear
at the bottom of the invoice, along with tax and/or shipping
costs, as needed. 

This is done with Word Tables, and here is a simple
example: Let's say you are billing a customer for 24 Widgets
at $89.99 each. Go to Table > Insert Table and choose, say,
10 Rows by 4 Columns. Click OK and your Table will
appear. 

In the upper left cell type Widgets. In the next cell type
24. In the third type 89.99. Finally click in the fourth cell
and go to Table > Formula, whereupon =SUM(LEFT) will
appear. This is Word's way of saying it sees some numbers
in the leftward preceding cells and assumes you want them
added up. However, if you overtype SUM with PRODUCT
and click OK, the correct answer of 2159.76 will appear. 

Repeat the above steps as needed for additional items.
Then click in the cell below your column of totals and go to
Table > Formula, whereupon =SUM(ABOVE) will appear.
Click OK for the correct grand total. Tax and shipping can
be added accordingly, meaning Word can be used as a
mini-spreadsheet program when needed. 

Colorizing Artwork
by Paul Vaughn
Alamo PC Organization, Inc.

P
reviously, I talked about different methods to colorize
photographs. This is not something that people have
to do frequently, but it is a fun way to make a cool

effect. A more common task that folks require is the ability
to add color to black and white artwork. It can be easy to
find the almost perfect piece of clip art, perfect accept for the
lack of color. This month we take a look at how to add color
to otherwise lifeless line art.

The artwork that you start
with can be from a variety of
sources. You can find illustrations
from a clip art CD, scan an image
from a public domain book or sim-
ply draw your own image and then
scan it. For my first example, I
drew a paint can in Adobe Illustra-
tor using a Wacom digitizing tablet
and then copied the artwork into
Adobe Photoshop CS. The Photo-

shop file should be in one of the color modes (usually RGB).
Since I pasted the art into Photoshop, the artwork is

automatically on a new layer. If you scanned the art (like I
did for my second example), create a new layer for it by
dragging the ‘Background’ layer to the New Layer icon in
the Layers palette. This will make a new layer called

‘Background Copy’, rename it
something descriptive like ‘Line
Art’ (Fig. 1). Now click on the
‘Background’ layer in the Layers
palette and fill it with white by
selecting Fill from the Edit menu.

The method we will look at for
coloring your art is what your
grade school teacher always
wanted: coloring inside the lines. In order to do this, you will
need to set the ‘Line Art’ layer’s Blending Mode to ‘Multiply’
in the pop-up menu at the top of the Layer’s palette. When
you use Multiply mode, the black artwork remains black,
but the white areas will show the underlying layers. Shades
of grey will darken the layers underneath.

Now create a new layer, title it ‘Color’ and position it
between the ‘Background’ and ‘Line Art’ layers. I like to
paint the color on a
layer separate from
the background,
but you can also
paint directly on
the background
layer if you wish.
Pick your favorite
painting tool and go
to town (Fig. 2).
Don’t worry if you
make a mistake,
simply use the
Eraser tool to touch up any stray color areas. Having the
color on a separate layer lets you use any of the adjustment
tools (Curves, Hue /Saturation, Levels, Color Balance, etc.)
to fine- tune your colors without affecting the art or the
background. You can also use any of the filters and effects
to enhance your picture.

O c c a s i o n a l l y ,
you may want to
colorize the linework
of your art instead of
the areas inside.
Photoshop gives you
great tools to do this
as well. Set up the
image the same way
as described above,
but leave the ‘Line
Art’ layer in Normal
mode. Next we are
going to use the
Channels palette
(usually found docked with the Layers palette or by choosing
Channels from the Window menu) to separate the artwork
from its white background. Select the composite RGB
channel (they should all be the same in a black and white
RGB image, but use the composite just in case) and click the
Load Channel as Selection button at the bottom of the
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Figure 5

palette (Fig. 3). When you do this, all of the white areas will
be selected and all of the black will not.

With the selection still active, click back on the RGB
Channel and then switch to the Layers palette and select
the ‘Line Art’ layer. Choose Inverse from the Select menu
and fill the selection with black. Inverse the selection again
and delete the selection by hitting the Delete key or choos-
ing Edit > Clear. Click the Lock Transparent Pixels button

to prevent painting out-
side the lines (Fig. 4) and
now you can use any of
the painting tools, in-
cluding the Brush, Gra-
dient, Paint Bucket and
Pencil, to color your art-
work. Using the Gradi-
ent tool can add an ele-
ment of dynamism to an
otherwise static image
(Fig. 5).

When you are fin-
ished, save a copy of the image in a flattened format, like
TIFF or JPEG, whichever format suits your needs best.

A little color can add a lot to ordinary illustrations and
clip art. Using the tools in Adobe Photoshop or any of your
other favorite paint programs you can customize your
artwork to give it your own personalized touch.

Paul Vaughn is a freelance graphic artist, writer and
web designer. More color equals more impact. If you would
like to see the Graphics Guy address a specific topic email
Paul Vaughn at paulv@mac.com. From the August 2004
issue of PC Alamode.

Tech News
by Sue Crane
Editor, Bearly Bytes
Newsletter of the Big Bear Computer Club, CA

W
indows XP Service Pack 2, scheduled for release
next month, will be available as a “critical” down-
load on the Windows Update site and will ship with

new PCs. The update will introduce technologies for net-
work protection, memory protection, secure e-mail handling,
secure browsing and PC maintenance. A new Windows
Security Center allows firewall monitoring, Automatic
Update and third-party anti-virus software and warns
customers when they need to apply patches. Microsoft will
probably ship free CDs, but consumers will probably pay for
shipping and handling.

Chipmaker, Intel, and PC makers are shifting the PC to
multimedia hub for the home. Intel predicts two new
categories

Entertainment PCs will imitate stereo and video
components, like a VCR, and will play music and DVDs,
record TV programs and even show picture slide shows. 

Entertainment PCs will use your TV for display and be
operated by remote control.
Lifestyle PCs, designed to inhabit bedrooms and kitchens,
will look like desktop computers and will be operable via

remote control or keyboard, allowing users to write an e-
mail and later play a video or music. Lifestyle PCs will also
come with multimedia software such as Windows XP Media
Center.

The new PCs will be pricey. An entertainment PC might
start at $700-$900 and sell for $1,400. Lifestyle PCs could
start at $600, but with a large flat panel display could sell
for as much as $2,000. PC makers have also announced
plans to offer special media adapters called the Windows
Media Center Extender, which will let consumers view
Media Center files on TVs. SnapStream Media has also
figured out a way to get your PC in touch with TV. Firefly
is a remote control that lets people manage media and
entertainment on their PCs — TV tuning, DVD playback,
streaming video, digital music players and photos. Firefly is
compatible only with Windows XP and Windows 2000 PCs
equipped with a 500MHz processor, 128MB of memory,
100MB of free hard disk space, and a CD or DVD drive.
Firefly will cost $49.99.

HP’s Media Center PC of the future has a remote control
with a built-in LCD screen for programming recordings. The
PC, known as the Windows Home Concept, also supports
Internet telephony, dual high-definition TV tuners, biomet-
ric security, and a built-in cable modem. For a web-based
slideshow and more information about these new concept
PCs, see: <http://www.eweek.com/article2/0,1759,1586428,00
.asp%20>

Internet2, the high-speed network designed to facilitate
scholarly collaboration among university researchers, has
spawned a new turbo-charged file-trading network dubbed
i2hub. University network administrators are concerned
that copyright violations are occurring and a computer
support specialist at Florida State University says: “The fact
is, (the network) cost a lot of money and downloading games
and music should be the last priority on any campus net-
work.”

Yury Gitman, a self-described “wireless and emerging-
media artist” in New York, has outfitted his bicycle with an
iBook laptop and Wi-Fi antennas so that everywhere he
goes, a cloud of free, high-speed wireless Internet access
follows. Demand for wireless Internet access in automobiles
has been picking up, and plans are to offer it in airplanes
soon.

Memory designer Rambus, has begun to license designs
for interfaces for DDR DRAM, or double data rate DRAM,
the most common type of memory found in PCs and a
technology that’s often used in consumer electronics devices.
The interfaces let another component retrieve data out of
DDR DRAM chips. A new version, called DDR 2, will be
released soon that runs at 533MHz. It will soon speed up to
800MHz.

Last year, Congress increased the amount small busi-
nesses can write off on new equipment purchases from
$25,000 to $100,000. Known as the Section 179 deduction or
the SUV tax, the increase is serving as motivation for sport
utility vehicle purchases, but also is an incentive to pur-
chase technology-related equipment. It’s available only
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through 2005, so businesses should decide quickly whether
or not to spend while the spending’s good.

IBM plans Web-based desktop software. Lotus Work-
place strategy, is a bundle that includes e-mail, word-
processing, spreadsheet and database applications aimed at
business users. The new software is designed to be distrib-
uted and accessed through a Web server, and accessible
from systems running Windows, MAC, Linux, Unix and
handheld devices. IBM hopes to sway customers to Lotus
Workplace with ease of management, mobility and price.
The new software is designed to be used offline, so mobile
users on laptops or handheld devices can connect, quickly
access applications and disconnect to work offline. IBM
plans to charge $2 per user per month for access to the
software, plus the cost of server software to make the system
work.

The History Channel’s 13-episode series on “Decisive
Battles” that debuts July 17 makes use of a not-yet-released
PC game to re-create the epic battles that mark ancient
Rome’s colorful history. “Rome: Total War” will be published
by Activision this fall. 

Society News
Treasurers Report
by Steve Staub
Balance as of 5/18/04 . . . . . . . . . . . . . . . . . . . . . $1,130.49
DepositsDeposits
Dues and picnic . . . . . . . . . . . . . . . . . . . . . . . . . . . $111.65
ExpensesExpenses
Labels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . $24.84
Postmaster (mailing permit) . . . . . . . . . . . . . . . . . . 150.00
St. Stephen’s (2 months) . . . . . . . . . . . . . . . . . . . . . 150.00
Paper (3 months) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98.24
Total $111.65
Balance as of 7/20/05 . . . . . . . . . . . . . . . . . . . . . . . $819.06

The Lighter Side

Mama Was the Best
 Computer Teacher I Ever Had

P
eople often ask me how I was able to learn so much
about computers. They never forget to remind me that
my parent’s generation didn’t have the same access to

computers that we enjoy today.
But the truth is this: Mama was the best computer

teacher that I ever had!
For years I badgered my mother with questions about

whether Santa Claus is a real person or not. Her answer
was always “Well, you asked for the presents and they came,
didn’t they?”

I finally understood the full meaning of her reply when
I heard the definition of a virtual device: “A software or
hardware entity which responds to commands in a manner
indistinguishable from the real device.”

Mother was telling me that Santa Claus is a virtual
person (simulated by loving parents) who responds to

requests from children in a manner indistinguishable from
a real saint.

Mother also taught the IF ... THEN ... ELSE structure:
“If it’s snowing, then put your boots on before you go to
school; otherwise just wear your shoes.”

Mother explained the difference between batch and
transaction processing: “We’ll wash the white clothes when
we get enough of them to make a load, but we’ll wash these
socks out right now by hand because you’ll need them this
afternoon.”

Mother taught me about linked lists. Once, for a
birthday party, she laid out a treasure hunt of ten hidden
clues, with each clue telling where to find the next one, and
the last one leading to the treasure. She then gave us the
first clue.

Mother understood about parity errors. When she
counted socks after doing the laundry, she expected to find
an even number and groaned when only one sock of a pair
emerged from the washing machine. Later she applied the
principles of redundancy engineering to this problem by
buying our socks three identical pairs at a time. This greatly
increased the odds of being able to come up with at least one
matching pair.

Mother had all of us children write our Christmas thank
you notes to Grandmother, one after another, on a single
large sheet of paper which was then mailed in a single
envelope with a single stamp. This was obviously an in-
stance of blocking records in order to save money by reduc-
ing the number of physical I/O operations.

Mother used flags to help her manage the housework.
Whenever she turned on the stove, she put a potholder on
top of her purse to reminder herself to turn it off again
before leaving the house.

Mother knew about devices which raise an interrupt
signal to be serviced when they have completed any opera-
tion. She had a whistling teakettle.

Mother understood about LIFO ordering. In my lunch
bag she put the dessert on the bottom, the sandwich in the
middle, and the napkin on top so that things would come out
in the right order at lunchtime.

There is an old story that God knew He couldn’t be
physically present everywhere at once, to show His love for
His people, and so He created mothers. That is the differ-
ence between centralized and distributed processing. As any
kid who’s ever misbehaved at a neighbor’s house finds out,
all the mothers in the neighborhood talk to each other.
That’s a local area network of distributed processors that
can’t be beat.

Mom, you were the best computer teacher I ever had.

Some Interesting Sites
GolfGolf
http://web.mit.edu/wnellie/www/miniputt.swf

Daily JigsawsDaily Jigsaws
http://www.shockwave .com /sw /mindgames/jigsaws/

Daily Geography QuizDaily Geography Quiz
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h t t p : / / w w w . n a t i o n a l g e o g r a p h i c . c o m / g e o b e e / a x
/newquizstart.html

Daily Charitable DonationDaily Charitable Donation
http://www .thehungersite.com/ will lead you to similar sites
for breast cancer, rain forests, child health, and animal
welfare.

Bumper StickersBumper Stickers
Wrinkled was not one of the things I wanted to be when I

grew up.

Failure is not an option. It comes bundled with the software.

How long is this Beta guy going to keep testing our stuff?

He who dies with the most toys is nonetheless dead.

A picture is worth a thousand words – but it uses up a
thousand times the mem-
ory.


